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Summary

The ARMermelator board has been conceived as a low cost, low power, general purpose embedded
board targeted for OEM development and integration. It has been designed to take advantage of the
ARM7TDMI architecture and reconfigurable logic using an Atmel AT91 processor and a Xilinx FPGA.

This guide will  get you started programming your ARMermelator board using RedBoot and the eCos
operating system.

Knowing your ARMermelator

The block diagram of the ARMermelator board is shown in Figure 1.

Figure 1: ARMermelator block diagram
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Figure 2 shows the top view of the ARMermelator board.

On the top, the board contains the following main components:

1. Vin power connector

2. Configuration jumpers

3. Linear regulator (optional)

4. DC/DC switching regulator

5. LEDs

6. Manual reset switch

7. Processor voltage supervisor

8. Clock crystal

9. Atmel AT91M42800A ARM7TDMI microcontroller

10.Intel Advanced Boot Block flash memory

11.SRAM memory

12.Expansion port A (XPA)

13.Expansion port B (XPB)

Figure 3 shows the bottom view of the board.
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Main components on the bottom of the board are:

1. Xilinx SpartanIIE FPGA

2. Programmable oscillator

AT91M42800A microcontroller

Block diagram

Figure 4 shows a diagram of the Atmel  AT91M42800A microcontroller.  Refer  to the AT91M42800A
datasheet for more information about the processor and the ARM documentation for details about the
ARM architecture.
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Figure 4: AT91M42800A block diagram
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Microcontroller pinout

Table 1 lists the AT91M42800A package pins and their associated signals.

P# Signal

1 GND

2 GND

3 nLB/A0

4 A1

5 A2

6 A3

7 A4

8 A5

9 A6

10 A7

11 A8

12 VDDIO

13 GND

14 A9

15 A10

16 A11

17 A12

18 A13

19 A14

20 A15

21 A16

22 A17

23 A18

24 VDDIO

25 GND

26 A19

27 PB2/A20/CS7

28 PB3/A21/CS6

29 PB4/A22/CS5

30 PB5/A23/CS4

31 D0

P# Signal

32 D1

33 D2

34 D3

35 VDDCORE

36 VDDIO

37 GND

38 GND

39 D4

40 D5

41 D6

42 D7

43 D8

44 D9

45 D10

46 D11

47 D12

48 VDDIO

49 GND

50 D13

51 D14

52 D15

53 PB6/TCLK0

54 PB7/TIOA0

55 PB8/TIOB0

56 PB9/TCLK1

57 PB10/TIOA1

58 PB11/TIOB1

59 PB12/TCLK2

60 VDDIO

61 GND

62 PB13/TIOA2

P# Signal

63 PB14/TIOB2

64 PB15/TCLK3

65 PB16/TIOA3

66 PB17/TIOB3

67 PB18/TCLK4

68 PB19/TIOA4

69 PB20/TIOB4

70 PB21/TCLK5

71 VDDCORE

72 VDDIO

73 GND

74 GND

75 PB22/TIOA5

76 PB23/TIOB5

77 PA0/IRQ0

78 PA1/IRQ1

79 PA2/IRQ2

80 PA3/IRQ3

81 PA4/FIQ

82 PA5/SCK0

83 PA6/TXD0

84 VDDIO

85 GND

86 PA7/RXD0

87 PA8/SCK1

88 PA9/TXD1/nTRI

89 PA10/RXD1

90 PA11/SPCKA

91 PA12/MISOA

92 PA13/MOSIA

93 PA14/nPCSA0/nSSA
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P# Signal

94 PA15/nPCSA1

95 PA16/nPCSA2

96 VDDIO

97 GND

98 PA17/nPCSA3

99 PA18/SPCKB

100 PA19/MISOB

101 PA20/MOSIB

102 PA21/nPCSB0/nSSB

103 PA22/nPCSB1

104 PA23/nPCSB2

105 PA24/nPCSB3

106 PA25/MCKO

107 VDDCORE

108 VDDIO

109 GND

110 GND

111 PA26

P# Signal

112 MODE0

113 XIN

114 XOUT

115 GND

116 PLLRCA

117 VDDPLL

118 PLLRCB

119 VDDPLL

120 VDDIO

121 GND

122 nWDOVF

123 PA27/BMS

124 MODE1

125 TMS

126 TDI

127 TDO

128 TCK

129 nTRST

P# Signal

130 nRST

131 PA28

132 VDDIO

133 GND

134 PA29/PME

135 nWAIT

136 nOE/nRD

137 nWE/nWR0

138 nUB/nWR1

139 nCS0

140 nCS1

141 PB0/nCS2

142 PB1/nCS3

143 VDDCORE

144 VDDIO

Table 1 : Microcontroller pinout

Some of these signals have a dedicated use in the ARMermelator board.

Microcontroller signal description

Table 2 shows the AT91M42800A signal descriptions as stated in the processor datasheet.
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Module Name Function Type Active Comments

EBI A[23:0] Address Bus Output All valid after reset

D[15:0] Data Bus I/O

CS[7:4] Chip Select Output High A23 - A20 after reset

nCS[3:0] Chip Select Output Low

nWR0 Lower Byte 0 Write Signal Output Low Used in Byte Write option

nWR1 Lower Byte 1 Write Signal Output Low Used in Byte Write option

nRD Read Signal Output Low Used in Byte Write option

nWE Write Enable Output Low Used in Byte Select option

nOE Output Enable Output Low Used in Byte Select option

nUB Upper Byte Select (16-bit SRAM) Output Low Used in Byte Select option

nLB Lower Byte Select (16-bit SRAM) Output Low Used in Byte Select option

nWAIT Wait Input Input Low

BMS Boot Mode Select Input Sampled during reset

PME Protect Mode Enable Input High PIO-controlled after reset

AIC IRQ[3:0] External Interrupt Request Input PIO-controlled after reset

FIQ Fast External Interrupt Request Input PIO-controlled after reset

TC TCLK[5:0] Timer External Clock Input PIO-controlled after reset

TIOA[5:0] Multi-purpose Timer I/O Pin A I/O PIO-controlled after reset

TIOB[5:0] Multi-purpose Timer I/O Pin B I/O PIO-controlled after reset

USART SCK[1:0] External Serial Clock I/O PIO-controlled after reset

TXD[1:0] Transmit Data Output Output PIO-controlled after reset

RXD[1:0] Receive Data Input Input PIO-controlled after reset

SPI SPCKA/SPCKB Clock I/O PIO-controlled after reset

MISOA/MISOB Master In Slave Out I/O PIO-controlled after reset

MOSIA/MOSIB Master Out Slave In I/O PIO-controlled after reset

nSSA/nSSB Slave Select Input Low PIO-controlled after reset

nPCSA[3:0]/nPCSB[3:0] Peripheral Chip Selects Output Low PIO-controlled after reset

PIO PA[29:0] Programmable I/O Port A I/O Input after reset

PB[23:0] Programmable I/O Port B I/O Input after reset

ST nWDOVF Watchdog Timer Overflow Output Low Open drain

CLOCK XIN Oscillator Input or External Clock Input

XOUT Oscillator Output Output

PLLRCA RC Filter for PLL A Input

PLLRCB RC Filter for PLL B Input

MCKO Clock Output Output
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Module Name Function Type Active Comments

Test &
reset

nRST Hardware Reset Input Input Low Schmitt trigger

MODE[1:0] Mode Selection Input

JTAG/ICE TMS Test Mode Select Input Schmitt trigger, internal pull-up

TDI Test Data In Input Schmitt trigger, internal pull-up

TDO Test Data Out Output

TCK Test Clock Input Schmitt trigger, internal pull-up

nTRST Test Reset Input Input Low Schmitt trigger, internal pull-up

Emulation nTRI Tri-state Mode Enable Input Low Sampled during reset

Power VDDIO I/O Power Power

VDDCORE Core Power Power

VDDPLL PLL Power Power

GND Ground Ground

Table 2: Microcontroller signal description

Memory map

The following table displays the memory map of the AT91M42800A microcontroller.

Address Function [BR] Function [AR] Size Special

0xffff_ffff

0xffc0_0000
On-chip peripherals On-chip peripherals

4MB Privileged, abort control

0xffbf_ffff

0x0040_0000
Reserved External device(s)

4MB [BR]

1/4/16/64MB [AR]

Abort control [AR]

0x003f_ffff

0x0030_0000
On-chip SRAM (8kB) Reserved

1MB

0x002f_ffff

0x0020_0000
Reserved on-chip device Reserved on-chip device

1MB

0x001f_ffff

0x0010_0000
Reserved on-chip device Reserved on-chip device

1MB

0x000f_ffff

0x0000_0000

External device(s) connected
to nCS0

On-chip SRAM (8kB)
1MB

Table 3: AT91M42800A memory map

Note that there are two memory spaces, one before the cancel remap command (BR) and one after it
(AR). The AT91M42800A comes out of  reset  with memory spaces remapped to allow proper device
initialization  using  a  non-volatile  memory  at  chip  select  0  (connected  to  nCS0  signal).  The  ARM
architecture has a hard-coded exception vector table at address 0x0000_0000, so in order to permit
dynamic exception vectors, stacks and code execution from the fast internal memory, the remap can be
canceled to place the on-chip SRAM beginning at address 0x0000_0000. The cancel remap command
also enables the other chip select memory spaces if they are enabled in the external bus interface (EBI)
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configuration registers.

Peripheral memory map

Table 4 lists the memory map of the internal peripherals of the AT91M42800A microcontroller. As with
most controller units, peripherals are configured and managed using registers at specific addresses. The
ARMermelator code distribution contains C macros and definitions for register locations and values that
follow the name convention used in the AT91M42800A datasheet.
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Address Peripheral Name Size

0xffff_ffff

0xffff_f000
AIC Advanced Interrupt Controller 4kB

0xffff_efff

0xffff_c000
Reserved 16kB

0xffff_bfff

0xffff_8000
ST System Timer 16kB

0xffff_7fff

0xffff_4000
PMC Power Management Controller 16kB

0xffff_3fff

0xffff_0000
PIOB Parallel IO Controller B 16kB

0xfffe_ffff

0xfffe_c000
PIOA Parallel IO Controller A 16kB

0xfffe_bfff

0xfffd_8000
Reserved 16kB

0xfffd_7fff

0xfffd_4000
TC1 Timer Counter 1 16kB

0xfffd_3fff

0xfffd_0000
TC0 Timer Counter 0 16kB

0xfffc_ffff

0xfffc_c000
SPIB SPI B 16kB

0xfffc_bfff

0xfffc_8000
SPIA SPI A 16kB

0xfffc_7fff

0xfffc_4000
USART1 USART 1 16kB

0xfffc_3fff

0xfffc_0000
USART0 USART 0 16kB

0xfffb_ffff

0xfff0_4000
Reserved 16kB

0xfff0_3fff

0xfff0_0000
SF Special Function 16kB

0xffef_ffff

0xffe0_4000
Reserved 16kB

0xffe0_3fff

0xffe0_0000
EBI External Bus Interface 16kB

0xffdf_ffff

0xffd0_0000
Reserved 16kB

Table 4: Peripheral memory map
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Jumpers

Figure 5 shows the board configuration jumpers.

Figure 5: Jumpers

1. MD[1:0] Mode pins (NPD)

These  normally  pulled-down  pins  control  the  operating  mode  of  the  microcontroller.  Refer  to  the
AT91M42800A datasheet for more information.

MD[1:0] Operating mode

00 Normal operating mode (internal crystal oscillator)

01 Normal operating mode (external XIN clock)

10 Boundary scan mode

11 Reserved

2. BMS – Boot Mode Select (NPD)

BMS is normally pulled-down. It selects the data width of the boot memory, connected to chip-select
nCS0.

The ARMermelator board has been designed to use 16-bit wide Intel Advanced Boot Block Flash memory.
This jumper could be used to boot from an external device with a different data bus width when the
main Flash memory is not populated.

BMS Boot memory

0 16-bit memory

1 8-bit memory

3. PME – Protected Memory Enable (NPD)

The normally pulled down PME signal controls the peripheral protect mode. Any attempt to access the
peripheral space when protection is enabled will result in the ARM core aborting the bus transfer. Refer
to the AT91M42800A datasheet for more information.
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PME Boot memory

0 PME disabled

1 PME enabled

4. TRI – Tristate (NPU)

The TRI jumper may be used to control the nTRI signal of the microcontroller. When pulled down, the
microcontroller outputs are tri-stated at reset. This operating mode is commonly used to connect an in-
circuit emulator (ICE) to the board. In the ARMermelator, this signal could also be used by the FPGA to
take control of the board.

This signal is shared with TXD1 and is sampled at reset.

5. GM[2,0] – FPGA Configuration Mode (NPU)

These jumpers are used to select the configuration mode of the FPGA. Without installed jumpers, the
default is slave serial mode without pre-configuration pull-ups.

The FPGA configuration is done by the microcontroller or an external controller connected to the shared
programmable IO pins (IOB set). JTAG configuration is always possible through the FPGA JTAG pins.

GM0 Configuration mode

0 Slave parallel (SelectMAP)

1 Slave serial

GM2 Pre-configuration pull-ups

0 Enabled

1 Disabled

6. FWP – Flash Write Protect (NPU)

This jumper controls the Flash  write  protect  pin of the Flash memory.  When FWP is down the Flash
memory contents cannot be overwritten. FWP is normally pulled-up.

LEDs

The ARMermelator board has 4 LEDs (2 independent bi-color LEDs).  They are used to indicate  board
power, board reset, and user programmable functions if SCK signals are not used.

LEDs are arranged in the following order:

LED name Color Details

Green LED Green MCU PA5, shared with SCK0

Red LED Red MCU PA8, shared with SCK1

Reset LED Green Connected to nRST line

Power-on LED Yellow Connected to +3.3V power
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External memories

ROM

Intel Advanced Boot Block in TSOP48(I) package is used to store non-volatile program memory and data.
This memory provides lockable 64kB blocks, finer grained 8kB boot blocks, a minimum of 100k erase
cycles and device identifiers. The ARMermelator board can support up to 16MB of Flash memory at chip-
select nCS0.

RAM

The ARMermelator board has been designed to allow up to 1MB of standard asynchronous static RAM in
the TSOP44(II) package. External SRAM is connected to chip-select nCS1.

FPGA

One  of  the main  characteristics  of  the  ARMermelator  board  is  that  it  has  been  conceived  to  take
advantage of the benefits of reconfigurable logic. This provides endless possibilities for device integration,
hardware acceleration and special function implementation.

Both Xilinx XC2S50E and XC2S100E SpartanIIE devices in the TQFP144 package are usable. The board
has  been carefully  designed to  provide optimum architecture flexibility  regarding microcontroller  and
FPGA usage.

FPGA pinout

Table 5 shows how the board signals are mapped to the FPGA pins.

P# Signal Alternate Location

3 SCK0 XPA

4 TXD0 XPA

5 RXD0 XPA

6 SCK1 XPA

7 TXD1 XPA

8 RXD1 XPA

10 D15 XPB

11 D14 XPB

12 D13 XPB

13 D12 XPB

14 D11 XPB

15 D10 XPB

18 D9 XPB

20 D8 XPB

P# Signal Alternate Location

21 D7 XPB

22 D6 XPB

23 D5 XPB

24 D4 XPB

26 D3 XPB

27 D2 XPB

28 D1 XPB

29 D0 XPB

30 A23 XPB

31 A22 XPB

32 A21 XPB

38 A20 XPB

39 A19 XPB

40 A18 XPB
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P# Signal Alternate Location

41 A17 XPB

42 A16 XPB

43 A15 XPB

44 A14 XPB

47 A13 XPB

48 A12 XPB

49 A11 XPB

50 IOB2 DLL1 XPA

52 CLKX GCK1 XPA

55 MCKO GCK0 XPB

56 IOB3 DLL0 XPA

57 A10 XPB

58 A9 XPB

59 A8 XPB

60 A7 XPB

63 A6 XPB

64 A5 XPB

65 A4 XPB

66 A3 XPB

67 A2 XPB

68 A1 XPB

69 A0 XPB

74 IOB16 nINIT XPA

75 IOB8 D7 XPA

76 nCS3 XPB

77 nCS2 XPB

78 nCS1 XPB

79 nCS0 XPB

80 IOB9 D6 XPA

82 IOB10 D5 XPA

83 nUB XPB

84 nWE XPB

85 nOE XPB

P# Signal Alternate Location

86 IOB11 D4 XPA

87 nWAIT XPB

89 PA29/PME Jumper

92 nRST XPA, XPB

93 nWDOVF XPB

94 IOB12 D3 XPA

95 IOB13 XPA

96 IOA12 XPA

97 IOA11 XPA

98 IOB13 D2 XPA

100 IOB14 D1 XPA

101 IOA10 XPA

102 IOA9 XPA

103 IOA8 XPA

104 IOB17 XPA

105 IOB15 DIN/D0 XPA

106 IOB5 DOUT/BUSY XPA

112 IOB6 nCS XPA

113 IOB7 nWRITE XPA

114 IOA7 XPA

115 IOA6 XPA

116 IOA5 XPA

117 IOA4 XPA

118 IOA3 XPA

121 IOA2 XPA

122 IOA1 XPA

123 IOA0 XPA

124 IOB4 XPA

125 IOB0 DLL2 XPA

126 CLK1 GCK2 XPA

129 CLK0 GCK3 XPA

131 IOB1 DLL3 XPA

132 FIQ XPB
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P# Signal Alternate Location

133 IRQ3 XPB

134 IRQ2 XPB

137 IRQ1 XPB

138 IRQ0 XPB

139 EK_SCL GA-EK

140 EK_SDA GA-EK

141 EK_CTRL1 GA-EK

142 EK_CTRL0 GA-EK

71 GA_DONE GA-MC

73 GA_nPROG GA-MC

35 GM0 M0 Jumper

33 M1 N/A

P# Signal Alternate Location

37 GM2 M2 Jumper

107 (IOB17) CCLK XPA

111 GA_TDI XPA

109 GA_TDO XPA

2 GA_TMS XPA

143 GA_TCK XPA

Table 5: FPGA pinout

Name convention:
• GA: gate array (FPGA)
• MC: microcontroller
• XPA, XPB: expansion ports
• EK: programmable clock oscillator

Note that some signals  have alternate functions.  Refer  to  the SpartanIIE  datasheet for  FPGA design,
configuration and usage information.

Some board signals shared between the microcontroller, FPGA and programmable clock oscillator are not
exported through the expansion ports. These are:

• DONE, nPROGRAM: control the FPGA configuration by the microcontroller (slave serial or slave parallel
modes).

• SCL, SDA, CTRL[1:0]: programmable clock oscillator configuration and control signals.

Since FPGA master configuration is not possible, M1 pin has been left unconnected.

Expansion ports

The ARMermelator contains  two expansion  ports  A and B,  labeled  XPA and XPB respectively.  These
expansion ports use 0.079” (2mm) pitch headers separated a distance of 1.78” (45.21mm).

Expansion  port  A  provides  peripheral  IO,  board  clocks,  microcontroller  JTAG/ICE  signals  and  FPGA
configuration  pins.  Expansion  port  B  provides  the  address  and  data  bus,  bus  control  signals  and
interrupts.

Expansion port A (XPA)

Figure 6 illustrates the pinout of the XPA connector.
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Figure 6: Expansion port A (XPA)

The following group of signals are available on XPA:

• Power signals: VEXT (external voltage input), +3.3V (regulated +3.3V), GND (ground)

• Microcontroller JTAG/ICE: nTRST, TCK, TMS, TDO, TDI

• FPGA JTAG: TCK, TMS, TDI, TDO

• External board JTAG: TDO, TDI

• Microcontroller mode pins: MODE0, MODE1

• Board clocks: XIN (I), CLKX (I), CLK0 (O), CLK1 (O)

• USARTs: SCK0, TXD0, RXD0, SCK1, TXD1, RXD1

• PIOs: IOA[13:0], IOB[17:0] (MCU PIO A and PIO B)
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• Reset: nRST

SCK0 and SCK1 are shared with the board LEDs.

The layout of microcontroller JTAG/ICE, FPGA JTAG and external board JTAG signals was designed to
allow daisy chaining of devices in a JTAG boundary-scan mode fashion. Also, nTRST has been placed
contiguous to nRST to ease shunting if both signals need to be asserted simultaneously.

In their alternate function, IOB signals are used to configure the FPGA in slave serial or slave parallel
(SelectMAP) mode. After FPGA configuration the shared signals may be used for other purpose. FPGA
clock DLL deskew signals are shared with the IOB[3:0] pins.

If the programmable oscillator is present, its clock outputs CLK0 and CLK1 are available on XPA. CLX is
an external clock input connected to FPGA global clock 1 net. The XIN input has been exported to admit
an  external  clock  input  to  the  microcontroller,  in  which  case  the  internal  crystal  oscillator  must  be
bypassed (using the MODE pins).

g
Caution

Care must be taken with the XIN pin. This pin is connected directly to the microcontroller
input of the crystal oscillator optimized for a 32.768kHz crystal.  Avoid any noise or stray
capacitance on XIN when using the 32.768kHz crystal because it will affect correct oscillator
operation.

Expansion port B (XPB)

Expansion port B layout is shown on Figure 7.
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Figure 7: Expansion port B (XPB)

The following set of signals are available on XPB:
• Power signals: VEXT (external voltage input), +3.3V (regulated +3.3V), GND (ground)

• Data bus: D[15:0]

• Address bus: A[23:0]

• Interrupt requests: IRQ[3:0] and FIQ (ARM fast interrupt request)

• Bus control: chip-selects nCS[3:0], nWAIT, nOE, nWE, nUB

• Reset: nRST and nWDOVF

• Master clock output: MCKO

The board Flash memory is connected to signal nCS0 and the external SRAM is tied to nCS1. The external
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bus must be configured appropriately through the EBI module registers in the microcontroller to allow
external memories and memory-mapped peripherals using chip-selects and/or address decoding. Refer to
the AT91M42800A datasheet for details.

nWDOVF is the watchdog overflow output. It can be used to alert the system that the watchdog has
expired and to perform a global reset.

If enabled, the master clock output signal will output the internal clock from the microcontroller.

Board power

For  integration  flexibility,  the  ARMermelator  board  was  designed  to  allow  different  power  supply
configurations. These configurations are selected during factory assembly depending on how the device
will be used upon user requirement.

The power supply system consists of a linear regulator (LM1117 or similar)  and an efficient switching
regulator (MAX1765). The latter has an integrated LDO regulator for FPGA core voltage generation.

U
Warning

Depending on the power configuration of your board, it  accepts  different voltage input
ranges. Always verify the DC input voltage before powering the device to avoid the risk of
damaging it.

Possible power configurations are:

1. Step-up DC/DC, +3.3V and +1.8V generation

In this configuration the system accepts a +1V to +3.5V input and generates the main +3.3V supply and
FPGA core +1.8V using the switching regulator. The linear regulator is not populated.

Total power consumption is 800mA @ +3.3V. The FPGA core voltage is generated with the MAX1765
LDO regulator and can supply a maximum of 500mA in steady state. This supply is derived from the
+3.3V supply.

2. Step-up DC/DC +1.8V, regulated +3.3V (independent supplies)

The linear regulator is used to generate the +3.3V supply, while the switching regulator generates +1.8V
efficiently. This configuration allows as much current the linear regulator can source for the +3.3V supply.

DC input voltage range for this mode is +3.5V to +5.5V.

3. Regulators for +1.8V and +3.3V (chained supplies)

This  mode  derives  the  +1.8V supply  from  the  linear  regulator's  +3.3V  supply.  The purpose  of  this
configuration is to allow extended DC voltage input. 
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g
Caution

As with any power supply, care must be taken to satisfy the linear regulator's electrical and
thermal requirements.

4. Stand-alone +3.3V

When the FPGA is not present in the board, the +1.8V supply is not needed. This low cost configuration
uses the linear regulator for dropout +3.3V generation and the switching regulator is not populated.

Connector polarity

Figure 8 shows the voltage polarity of the power connector in the ARMermelator board.

GNDGNDGNDGND

VINVINVINVIN

Figure 8: Connector polarity

Reset considerations

The processor supervisor  takes  care  of  proper board initialization  holding the reset  line (nRST signal)
down for approximately 800ms after power-up.

The manual reset switch allows to reset the board bringing the reset line directly and momentarily to
ground.  The  open-drain  output  of  the  voltage  supervisor  makes  this  possible.  The  reset  switch  is
debounced with an RC filter.

JTAG/ICE

The ARM7TDMI architecture provides an embedded ICE debug interface that uses the JTAG port of the
processor (EmbeddedICE/RT interface). Through this interface it is possible to halt the processor, examine
its registers, step through program code, etc.

ARM suggests a standard 20-pin debug pod connection between the host system and the target system
being tested, as shown in  Figure 9. Since the ARMermelator was designed for a minimum integration
footprint, it needs an adapter to connect it to a debug pod.
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Figure 9: ARM JTAG/ICE connector

The  AMLprogrammer  (Figure  10)  board  aids  in  the  ARMermelator  debugging  process  adapting  its
expansion ports to the standard ARM debug interface.

Figure 10: AMLprogrammer

It also provides two RS232 transceivers connected to the microcontroller UART signals and 6-pin MiniDIN
connectors. The pinout of each connector is shown in Figure 11.

Figure 11: AMLprogrammer RS232 pinout

The AMLprogrammer features a second 10-pin header that exports the FPGA JTAG signals as illustrated
in Figure 12.

Figure 12: JTAG connector
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Figure 13 illustrates the correct way to insert an ARM JTAG/ICE pod in the AMLprogrammer board. Note
that the #1 pins of both JTAG and JTAG/ICE headers face outwards. The AMLprogrammer must be
inserted  such  that  the  RS232  MiniDIN  connectors  are  placed  above  the  ARMermelator  board
microcontroller and the JTAG and JTAG/ICE pins are contiguous to the ARMermelator board jumpers.

JTAG/ICEJTAG/ICEJTAG/ICEJTAG/ICE

JTAGJTAGJTAGJTAG
RS232ARS232ARS232ARS232A

RS232BRS232BRS232BRS232B

Figure 13: JTAG/ICE pod insertion

The AMLprogrammer also features two extra jumpers:

• The RSTC jumper chains the board reset signal with the nTRST JTAG/ICE reset signal. This allows a
global reset to initialize and synchronize both the in-circuit emulator and the microcontroller.

• The  SCEN jumper  disables  the  RS232 transceivers  tri-stating  the  driver  inputs  connected  to  the
microcontroller RXD pins. This is useful if the AMLprogrammer is going to be used only as a JTAG/ICE
adapter and other peripheral will control the RXD pins, or they will be configured as outputs by the
microcontroller.

Board dimensions

For reference, Figures 14 and 15 illustrate the ARMermelator board and module mechanical dimensions,
expressed in mils (1/1000”).
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Figure 14: ARMermelator board dimensions

Figure 15: ARMermelator module dimensions
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Developing with the ARMermelator

Preliminaries

The distribution CDROM contains all the necessary software tools and applications to develop with the
ARMermelator. The CDROM contains:

• GNUARM toolchain (includes GNU compilers and tools like Insight/GDB debugger)

• eCos distribution + ARMermelator patches (aml)

• Eclipse IDE

• Macraigor's OCDLibRemote proxy

• Xilinx WebPACK ISE

• Atmel and Xilinx documentation

This guide will show you step-by-step ARMermelator development examples with RedBoot and eCos. The
examples have been compiled in MS Windows under the  Cygwin environment. It is assumed that the
GNUARM toolchain and ARMermelator eCos distribution have been already installed in your system.

RedBoot

RedBoot is the RedHat bootstrap environment. RedBoot uses a minimal eCos footprint and is integrated
in the eCos distribution as a standard template.

RedBoot configuration

This guide will use the graphical eCos Configuration Tool for RedBoot and eCos configuration. This tool
usually resides in the tools/bin subdirectory of the eCos distribution (the  repository). The tool allows
the user to specify eCos parameters and options in an intuitive way.

On startup, the tool window will look like in the following figure:
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If this is your first time you work with the configuration tool, you must configure the tools path:

Select the menu Tools->Paths->Build Tools..., enter the path of your GNUARM toolchain binaries
and press OK:

Now enter the path of your user tools selecting the menu Tools->Paths->User Tools... and press

OK:
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In this case we are using the Cygwin environment. The configuration tool needs to know where to find
tools like make to build the eCos libraries and executables.

We will  now use an eCos pre-defined template to configure a RedBoot image for the ARMermelator
board. Select the menu Build->Templates... and the next pop-up window should appear:

In this pop-up select the “ARMoid ARMermelator board (AT91M42800A)” choice from the Hardware
options and the “redboot” package from the Packages list.

Now click  OK. The configuration tool checks  for dependencies required by the package and resolves
conflicts between them recursively. Click on the Continue button to accept the solutions proposed by the
configuration tool.

It is time now to configure the package we selected with our custom options. First, we are trying to build
a resident RedBoot, so it must be located in ROM. Open the “eCos HAL” branch in the Configuration
tree,  then select  “ARM architecture”  and “Atmel AT91 variant HAL”. For the “Startup type” option
choose “ROM”. Again, the configuration tool will  check dependencies for you. Click on Continue to
resolve them.

The default options of the “redboot” package include the exec command in the “Build Redboot ROM
ELF image” options of the “Redboot ROM monitor” node. This command is used to execute non-eCos
applications with optional initialization parameters (like a Linux kernel). In our case this command is not
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needed so it must be opted out. Uncheck the “Include exec command” option under the “Build Redboot
ROM ELF image branch” node.

The  configuration  process  for  this  example  is  now  ready.  You  must  save  the  configuration  in  an
appropriate place. We suggest you to create an empty subdirectory in your favorite code repository since
the configuration tool will build the application images relative to where you store eCos the configuration
file (ECC extension). In our case, we have named our configuration “redboot”.

Building RedBoot

We are now ready to compile our RedBoot image. From the menu bar, select the  Build->Generate
Build Tree option.  The  configuration  tool  will  create  the  following  subdirectories  relative  to  the
redboot.ecc ECC configuration file:

Directory Description

redboot_build Stores object files of the build process

redboot_install Contains  the  images,  libraries,  include files  and other  necessary  files  to  use  the
compiled eCos application.

redboot_mlt Used to store memory layouts to generate targets with different memory layouts.

Now select  the menu  Build->Library (F7) and the compiling process will  begin. Once the build
process is finished, your tool window will look like the next figure:
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Check out the redboot_install/bin directory. The files listed in this table should be there:

File name Description

redboot.bin Pure code binary image file

redboot.elf ELF image file

redboot.img ELF image file without debugging symbols

redboot.srec Image in S-record format

Also, the next files must be located in redboot_install/lib:

File name Description

extras.o
libextras.a

Required extra object files for the current package

libtarget.a Main package library file

target.ld Package linker script

vectors.o Exception vectors and startup code

version.o Version information
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The  redboot_install/include file contains automatically generated target header files.  customized
with the package configuration options.

The build process is now complete. We will write the RedBoot binary image to the ARMermelator Flash
memory.

Remote debugger

This example uses Macraigor's OCDLibRemote GDB proxy debugger to connect the ARMermelator board
with the host PC using a wiggler-like debug interface. Basically,  the debug interface adapts the signal
voltage levels of the 20-pin JTAG/ICE header in the AMLprogrammer to the voltage levels of the parallel
port  in the PC. The OCDLibRemote debugger also supports  other debug adapters.  You can also use
another third party debugger supporting the EmbeddedICE/RT interface.

To start the debugger, in a shell window type:

OcdLibRemote -c ARM7 -d WIGGLER �

e

Tip

The OCDLibRemote proxy debugger exits every time GDB exits. You can instruct the shell to
always restart the debugger easily with the following command:

while true; do OcdLibRemote -c ARM7 -d WIGGLER; done �

You can also put that command in a custom script.  When your debugging session ends,
cancel the while loop with Ctrl+C.

Flasher application

We will now build the flasher application and download it to the board in order to write the RedBoot
image to the Flash of the ARMermelator.

aoan001 (v1.4) July 18, 2004 29



ARMermelator Quick Start Guide

The ARMoid distribution contains a directory called  tools. In this directory you will find board support
utilities like the amlboot Xmodem bootloader and the amlclear zero-boot block eraser. These are very
simple utilities that help programming and bootstrapping the board for the first time or when there is no
initialization code in the Flash memory.

amlboot

When the processor comes out from reset, only the internal 8kB RAM and the memory space at chip-
select nCS0 are enabled by default. The processor has been designed to boot from this latter memory
space, so the device at chip-select nCS0 and the internal RAM are “remapped” after reset to addresses
0x0000_0000 and 0x0030_0000 respectively. In the ARMermelator board the Flash memory is connected
to chip select nCS0. Evidently, if the Flash memory is clean there will be no initialization code executed
and the board will not be able to boot.

The eCos/RedBoot environment has been designed to initialize its targets properly and to execute either
from ROM or RAM. However, a typical RedBoot configuration has a code memory footprint near 50kB.
The ARMermelator's AT91M42800A processor has only 8kB of internal RAM. Thus, a small middleware
utility is needed to initialize the board adequately and to be able to download programs as RedBoot to
the board memories.

The amlboot utility has been designed to run in the limited internal RAM space of the AT91M42800A. It
loads and executes at address 0x0030_0000 while the stack is located at the top of the internal RAM. Its
main job is to receive a program via the Xmodem protocol and write it to the Flash memory beginning at
offset 0x0000_0000.

amlclear

If there is a valid program stored in the Flash, it will commonly perform processor initialization including
the remap command. This means that the internal memory is going to be relocated to absolute address
0x0000_0000  and  the  Flash  memory  will  begin  elsewhere.  The  amlclear  utility  loads  at  address
0x0000_0000 and clears the first block of the Flash memory, assuming it has been located at address
0x0100_0000. When the board  is reset  it  will  no longer perform a remap command and it  will  be
possible to load the amlboot utility in the internal RAM at the usual address 0x0030_0000.

w
Note
Most probably your board was shipped from factory with RedBoot pre-programmed in its
Flash memory. It is important for you to know how to debug and reprogram your board in
case the RedBoot image gets corrupted by awry code, or if you wish to modify the RedBoot
options or even install a completely different program at the boot location.

To build the amlboot application change to the ARMoid utilities directory and type:
make amlboot.elf �

The libao.a and libarch.a libraries and the amlboot.elf application will be compiled:
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Downloading and running

We will assume that the Flash memory boot block is clean so the processor will have its internal RAM at
address 0x0030_0000 after reset (no initialization code is executed).

Connect your ARMermelator board to the host using your debugging tool and power the device. To
enter the ARM-ELF GNU debugger GDB, in a shell type:

arm-elf-gdb amlboot.elf �

We will also need an Xmodem-capable terminal utility. If you are working under MS Windows you can
use the HyperTerminal application. Connect the serial cable to UART1 of the ARMermelator and open
and configure your serial port for 38400 baud, 8 data bits, no parity, 1 stop bit and no flow control.
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w
Note
By default, RedBoot uses the AT91M42800A USART0 for the GDB monitor and USART1 for
the RedBoot console. In the AMLprogrammer board, the connectors for UART0 and UART1
are labeled RS232A and RS232B respectively.

Now type the following commands:

GDB command Description

target remote localhost:8888 � Will  connect  to  the  OCDLibRemote  GDB  proxy.  The  remote
debugger listens to port 8888. You can also debug remotely to
another host, in that case replace localhost appropriately.

load � Will load the code from the amlboot.elf image into the target's
memory through the GDB proxy and the JTAG/ICE interface.

break exit � Inserts  a  breakpoint  upon  entry  to  the  exit function.  This
function  is  entered  when  main exits  so  we  know  that  the
program has finished running

continue � Will run the program from its start address.

If there are no errors, you should see the following message in your GDB proxy window after issuing the
target command:

e
Tip

In GDB you can abbreviate commands. For example:

• lo: load
• b: break
• c: continue

32 aoan001 (v1.4) July 18, 2004



ARMermelator Quick Start Guide

The following snapshot shows how your GDB session should look:

Using Xmodem

After beginning program execution with GDB's continue command, a “Ready” message will appear on
the terminal. Following that, some “C” characters will start to show. This means that the amlboot utility
is waiting for Xmodem transfers with the binary image to be flashed.

In HyperTerminal select the Transfer->Send File... menu and the next pop-up will show up:

Browse for the redboot.bin file in the Filename input (located in the redboot_install/bin directory)
and choose Xmodem as the Protocol. Click on Send and the file transfer should begin:
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If there are any transfer  errors  the communication will  be aborted.  You can start  the process  again
issuing  the  load  command  and the  continue  command.  If  there  are  no  errors  your  HyperTerminal
windows will look like the following image:

Since we placed a breakpoint at the exit function, GDB will halt the program execution once this function
has been reached.
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a
Advanced

During  development,  the whole  process  of  manually  downloading code  with  GDB may
become tedious. A convenient way to automate this process is to use shell scripts and GDB
scripts. For example, an  amlboot.sh script to download the amlboot utility and flash the
board may be:

#! sh
arm-elf-gdb –-nx –command=amlboot.gdb

This shell script calls  the ARM-ELF GDB debugger with the following  amlboot.gdb GDB
script:

echo ARMermelator boot sector flasher\n
file amlboot.elf
set confirm off
set debug remote 0
target remote localhost:8888
load
break exit
continue
quit

Then just have your HyperTerminal ready and call the amlboot.sh shell script.

Using RedBoot

Disconnect now your debug tool from the board and press the reset button. You should see the RedBoot
command line:
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Enter the help command and feel free to try some other commands:

help �

Q
Congratulations!

You have just learnt how to  use the eCos Configuration Tool to configure and build a
RedBoot image for your ARMermelator board. You also used the ARMoid utilities and GNU
tools to write binary images in the ARMermelator Flash memory.

eCos

We will now build an eCos kernel and a demonstration program. Then we will download the application
to the board using the Xmodem protocol with RedBoot's loader.

As with RedBoot, the eCos development philosophy is that a package is first configured and built. While
RedBoot  was  a  stand-alone  eCos  package,  an  eCos  kernel  will  be  used  as  the  framework  of  an
application. We will compile our eCos program and then link it against the eCos kernel.

Configuring eCos

The eCos kernel configuration process follows the same steps as RedBoot's configuration.

Run the  eCos Configuration  Tool  and select  the  Build->Templates... menu.  Select  the  ARMoid
ARMermelator option and the “default” package. Press Continue to resolve dependency conflicts with
the proposed options.
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Building eCos

Since we wish to download the application to the board's external RAM, make sure that the “Startup
type” option in the  Configuration->eCos HAL->ARM architecture->Atmel AT91 variant HAL
branch is of type RAM.
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Name your configuration as “default” and save it  in an appropriate  place. Select  Build->Generate
Build Tree followed by Build->Library. The compilation process should begin. When finished, check
the files in the default_install/lib subdirectory (relative to the default.ecc configuration file you
saved). Your directory should contain the same files listed in this snapshot:
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Using eCos

We just compiled the eCos kernel. The output of this process is the kernel library and associated object
files plus the target.ld linker script.

To use these files with our application, it is better to write a Makefile. Create a directory called “app” in
the directory where you placed the default.ecc configuration file. Create a text file called “Makefile”
in the app directory with the contents shown below:

Listing 1: Makefile for eCos application

# set this variable to point to your kernel install directory
ECOS_INSTALL = ../../ecos/default_install

ARCH = arm-elf
CPU = -mcpu=arm7tdmi
MODEL = -mthumb -mthumb-interwork

CC = $(ARCH)-gcc $(CPU) $(MODEL)
LD = $(ARCH)-ld $(CPU) $(MODEL)
OBJCOPY = $(ARCH)-objcopy
OBJDUMP = $(ARCH)-objdump

INC = -I$(ECOS_INSTALL)/include
LIB = -L$(ECOS_INSTALL)/lib -Ttarget.ld

CFLAGS = -g -O2 -Wall -Wcast-align -fverbose-asm $(INC)
LDFLAGS = -nostdlib -nostartfiles $(LIB)

%.e: %.c
$(CC) -E -o $@ $^

%.elf: %.o
$(CC) $^ -o $@ $(LDFLAGS) -Wl,--cref,-Map,$*.map
$(OBJDUMP) -xdStr $@ > $*.lst

%.srec: %.elf
$(OBJCOPY) -O srec $^ $@

%.bin: %.elf
$(OBJCOPY) -O binary $^ $@

clean:
$(RM) *.e *.o *.elf *.map *.lst *.srec *.bin

distclean: clean
$(RM) *.bak *~

In the app directory we will also put our application code. Now launch your favorite text editor and create
a C file called “hello.c” with the following code:
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Listing 2: hello.c eCos example

/*
Small eCos test

*/

#include <cyg/kernel/kapi.h> // Kernel API
#include <cyg/kernel/diag.h> // Diagnostics

#define THREAD_STACKSIZE 1024
#define THREAD_PRIORITY 12

int thread_stack[THREAD_STACKSIZE];

cyg_thread thread;
cyg_handle_t handle;

void
thread_0(cyg_addrword_t d) {

while (1) {
diag_printf("Thread 0 says hello\n");
cyg_thread_delay(100);

}
}

void
cyg_user_start() {

diag_printf("Okay!\n");

cyg_thread_create(
THREAD_PRIORITY,
thread_0,
0,
"Thread 0",
(void *)thread_stack,
THREAD_STACKSIZE,
&handle,
&thread

);

cyg_thread_resume(handle);
}
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Now type:

make hello.elf �
make hello.srec �

These commands will compile your code into an object file using the headers of the eCos kernel you
configured and built. Then it will link the object file with the eCos libraries to generate the ELF executable
of your application. The SREC file is the S-record file we will download to the board.
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Boot your board and the RedBoot console should appear. Use the load command to download your
application to the board's memory with RedBoot:

load -m xmodem �

As before with the amlboot and the RedBoot image, select the Transfer->Send File... menu and
choose the hello.srec file and Xmodem protocol:
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Click on the Send button and the transfer will begin:

Once the transfer is finished, the RedBoot prompt will show again. Issue the go command to instruct
RedBoot to jump to your program's start address:

go �
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Your program will begin executing now.

Testing

Now that we have built a default eCos kernel, we can build some eCos tests to perform real live checks
in  our board.  As a  final  activity,  we will  use the eCos testing facilities  that are  incorporated  in  the
Configuration Tool.

Platform configuration

First  of all,  we need to tell  the configuration tool how to communicate with our board. Choose the
Tools->Platforms... menu. A pup-up window will appear:

Press the Add button and a second pop-up will show up. Fill the form fields as illustrated in the next
figure:
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Example:

Platform name aml

Command prefix arm-elf

Arguments for GDB set height 0
set debug remote 0
set remotebaud %b
target remote /dev/ttyS0
load
break cyg_test_exit
break cyg_assert_fail
break cyg_test_init
cont
set cyg_test_is_simulator=0
cont
bt

Inferior arm-elf-gdb -nw -q %e

Prompt (gdb) 

The wildcards %b, %p and %e may be used for the baud rate, port and GDB arguments. Now press OK
to remove the pop-ups. Select the View->Settings... menu and check that the parameters under the
“Run Tests” tab are correct for your system:

Press OK.

Building and running tests

With the “default” configuration open, select  the  Build->Tests menu. The compilation of the test
images will begin.
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After the build process stops, select the Tools->Run Tests... menu. The following pop-up will show
up:

You can now select the tests you wish to run. When you are done, press the Run button and the testing
process will start:

Make sure that the serial port you have selected corresponds to the AT91M42800A USART0 (RS232A
connector of  the AMLprogrammer board);  this  is  where RedBoot's GDB monitor listens remote GDB
requests. Reset your board and press the OK button. The tests will be executed one-by-one. You can take
a peek to what is happening selecting the “Output” tab:
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The transcript of a test session is shown below:

aoan001 (v1.4) July 18, 2004 47



ARMermelator Quick Start Guide

Listing 3: eCos test session

Run started
(gdb) set height 0
(gdb) set debug remote 0
(gdb) set remotebaud 38400
(gdb) target remote /dev/ttyS1
Remote debugging using /dev/ttyS1
0x01002dc4 in ?? ()
(gdb) load
Loading section .rom_vectors, size 0x40 lma 0x2008000
Loading section .text, size 0x62a8 lma 0x2008040
Loading section .rodata, size 0x43c lma 0x200e2e8
Loading section .data, size 0x34c lma 0x200e724
Start address 0x2008040, load size 27248
Transfer rate: 27248 bits/sec, 309 bytes/write.
(gdb) break cyg_test_exit
Breakpoint 1 at 0x200a8e4: file /ecos-d/ecos/packages/infra/current/src/tcdiag.cxx,
line 273.
(gdb) break cyg_assert_fail
Function "cyg_assert_fail" not defined.
(gdb) break cyg_test_init
Breakpoint 2 at 0x200a7f4: file /ecos-d/ecos/packages/infra/current/src/tcdiag.cxx,
line 198.
(gdb) cont
Continuing.
[New Thread 1]
[Switching to Thread 1]

Breakpoint 2, cyg_test_init ()
    at /ecos-d/ecos/packages/infra/current/src/tcdiag.cxx:198
198 }
(gdb) set cyg_test_is_simulator=0
No symbol "cyg_test_is_simulator" in current context.
(gdb) cont
Continuing.
PASS:<Sched 1 OK>
EXIT:<done>
[New Thread 3]
[Switching to Thread 3]

Breakpoint 1, cyg_test_exit ()
    at /ecos-d/ecos/packages/infra/current/src/tcdiag.cxx:273
273     for(;;)
(gdb) bt
#0  cyg_test_exit () at /ecos-d/ecos/packages/infra/current/src/tcdiag.cxx:273
#1  0x020086f0 in entry0 (data=0) at thread.inl:375
#2  0x0200a9c0 in Cyg_HardwareThread::thread_entry(Cyg_Thread*) (
    thread=0x200fd88)
    at /ecos-d/ecos/packages/kernel/current/src/common/thread.cxx:109
(gdb) Run complete

The “Summary” tab lists information and results of the eCos tests:
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Q
Congratulations!

You now know how to build eCos applications and download them to the ARMermelator
board using RedBoot. You have used RedBoot's built-in GDB remote debugging agent to
test eCos programs in the ARMermelator board.
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